Adobe: Certified Expert
Program

Product Proficiency Exam Bulletin

Adobe® After Effects® CS5
Exam # 9A0-152

ACE Certification Checklist
The checklist below will help guide you through the process of obtaining ACE certification.

Review this bulletin to become familiar with the topic areas and objectives of the exam.
Identify the topic areas and objectives you need to study.
Determine which study materials you need to improve your skills.

For a list of recommended study materials, visit:
http://www.adobe.com/misc/training.html

Study for the exam.
Contact Pearson VUE to register for an exam: http://www.pearsonvue.com/adobe
When registering for the exam, refer to the exam number located at the top of this bulletin.

Take the exam.Your score is electronically reported to Adobe and will also be displayed
when you complete your exam.

Upon passing the exam, your certificate will be sent to you via email. Please ensure that
you have provided an accurate email address.

You can update your certification profile by going to: http://www.adobe.com/support/
certification/community.html. You will need the information provided on your score report
to create a user account.
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Exam Structure

The following lists the topic areas and percentage of questions delivered in each topic area:

Topic Area % of # of
Exam Questions
User interface and Workflows 4% 3
Importing and organizing footage items 7% 5
Working with other software 5% 4
Projects and compositions 5% 4
Working with layers in the Timeline 9% 6
Views and previews 5% 4
Building 3D compositions 4% 3
Color and HDR 4% 3
Drawing, painting, and paths 8% 5
Shape Tools 8% 5
Creating and animating Text 4% 3
Transparency and compositing 5% 4
Working with Effects 9% 6
Markers and metadata 4% 3
Memory, storage, and performance 5% 4
Tracking 4% 3
Expressions 5% 4
Rendering and exporting 5% 4

Number of Questions and Passing Score
e 73 questions
e 65% minimum required to pass

Test Content: Topic Areas and Objectives

Following is a detailed outline of the information covered on the exam.

1. User interface and Workflows
» Given a scenario, configure a workspace.

« Given atool on the Tools panel, explain the purpose of the tool. (Tools include: Camera

tool, Pan Behind tool, Shape tools, Puppet Pin tool)

» Given a scenario explain how to manage duplicate footage and undo history.

2. Importing and organizing footage items

 List and describe the process and options available for previewing compositions and

footage.
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Discuss ways to determine footage field order.

Discuss cross-platform project considerations.

Discuss different options for importing files to the project.

Given a scenario explain how to replace an existing footage item.

Working with other software

List and describe the functionality of importing files from other Adobe applications.
(Adobe applications include: Photoshop, Illustrator, Premiere, Flash)

List and describe the functionality when working with other supported file types. (Other
supported file types include: Cinema 4D, Targa sequence, other sequences)

Discuss export of content for use in Adobe Flash.
Explain how to link and create compositions using Adobe Dynamic Link.

Projects and compositions

Discuss the uses of a template project.

Given a scenario explain how to create and view compositions.

Given a scenario explain how to control thumbnails in the Project panel.

Explain the purpose and uses of the composition navigator bar.

Working with layers in the Timeline

Given a scenario, discuss the ability to update layers in other Adobe applications.
Discuss methods of selecting, moving and aligning layers in the timeline.
Explain how to use individual position properties for a layer.

List and describe the advantages of Null objects.

Given a description, choose which one of the transform modes will deliver the required
result.

Given a scenario, explain methods of a sizing a solid layer.

Views and previews

Given a scenario, explain the uses of standard preview.

Discuss ways to speed up performance when working with complicated compositions.
Explain ways to avoid rendering unnecessary pixels.

Discuss the affect of changing the zero point (origin) for the rulers.

Building 3D compositions

Describe the functionality of the unified camera tool.

Discuss viewing and orienting 3D layers.

Explain a setting in the Camera Dialog box.

Given a scenario, explain how to rig a camera by using parenting and/or a null objects.
Color and HDR

List and describe High Dynamic Range (HDR) and Color management advantages.
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Explain how to assign a color profile to a footage item.

Discuss ways to keep colors as broadcast safe.

Drawing, painting, and paths

Discuss attributes in the brushes panel.

Discuss ways to affect the interpolation of vertices on a mask.

Given a scenario, explain how to apply a motion blur to a mask.

Discuss ways to use a mask to create position keyframes.

Rotoscope a foreground object from the background by using the Roto brush.

. Shape Tools

Identify and explain options in the line cap for strokes.

Alter shapes with path operations.

Discuss the operation of Wiggle Transform for a shape layer.
Discuss and explain fill and stroke creation.

Describe the purpose of the first vertex of a path.

. Creating and animating Text

List and describe the options available for formatting fill and stroke.
Discuss the purpose of a value under the range selector properties.
Explain the process of animating text by using multiple selectors.

. Transparency and compositing

Configure transparency values and blend modes where multiple layers or masks intersect.
Discuss the uses of a garbage matte.

Given a scenario, explain how to use transparent pixels on one layer to affect another.
Discuss ways to prepare footage when working with keying effects.

. Working with Effects

Describe different methods to save an animation preset.
Suggest a solution for warning icons in the effects panel.
Name effects that can use a native 3D comp camera.

Discuss options and categories in the Effects & Presets panel.
Discuss the operations of common effects properties.

Given a scenario, explain the functionality of a given panel within the Color Finesse Effect
dialog box.

. Markers and metadata

Discus options for defining markers on the timeline.
Explain the different appearance of markers in the timeline.
List and describe video formats which support XMP metadata upon import.
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15.

Explain the process required for adding queue points to the timeline when exporting to
FLV.

Memory, storage, and performance

Given a scenario, explain which steps to take when you see an alert message about memory
or display.

Discuss Render Multiple Frames Simultaneously.

List and describe the options and procedures for memory requirements and optimum
performance in After Effects.

Discuss the main use for the Caps Lock key.

. Tracking

Describe a scenario for choosing two track points at the same time.

Explain the operation of buttons and options in the Tracker Panel.

Given a scenario, explain the use of the Parallel Corner Pin.

Explain the process for motion tracking hand drawn masks by using the Mocha v2 plug-in.

. Expressions

List a number of arguments that can be plugged into a given expression.
Explain how to temporarily disable an expression.

Given a scenario, discuss when to use an Array object.

Explain the purpose of motion graph related to expressions.

. Rendering and exporting

Describe the options for a rendering process in After Effects.

Given a scenario, configure the appropriate options in the Render Queue panel to render a
movie.

Explain how to arrange and re-import your render files.
List supported features of OpenGL rendering.

Practice Exam

Try out these practice questions to get a feel for the types of questions on the ACE exam. Please
note that your performance here does not indicate how you will do on the actual exam. To fully
prepare for the exam, closely review the topic areas and objectives in this Exam Bulletin.

Given a scenario, configure a workspace.

When previewing an After Effects composition that contains several nested compositions, a
Timeline panel different from the current Composition panel plays. Why does this occur?

A
B.

The Timeline panel is locked.
The Composition panel is locked.
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C. The Maximize Frame command has been enabled for the Timeline panel.

D.

The Maximize Frame command has been enabled for the Composition panel.

Correct answer: B

Discuss different options for importing files to the project.

What should you do in order to import the contents of a folder as a series of still images that
appear in the Project panel as a single footage item?

A.
B.
C.

D.

choose File > Import > File, locate the folder and click the Import Folder button
choose File > Import > File, locate the folder, Shift select all the files, and click Open

choose File > Import > Multiple Files > Locate the folder, Shift select all the files, and
click Open

choose File > Import > File, locate the folder, select the first image file in the list, check
the “Sequence” option, and click Open

Correct answer: D

Explain how to link and create compositions using Adobe Dynamic Link.

You have imported an After Effects composition with specific color depth settings as a
Dynamic Link file into Premiere Pro. How will it be rendered?

A.
B.
C.

D.

Using the color depth of the After Effects project, depending on the project settings
Using the color depth of the Premiere Pro project, depending on the sequence settings

At 8 bit per channel, unless you marked the “use maximum bitdepth” switch in Premiere
Pro

At 32 bit per channel, expect for sequences or formats that are not supported

Correct answer: A

Discuss methods of selecting, moving and aligning layers in the timeline.

What is the minimum number of layers that you need to select when Composition is chosen in
the Align Layers To menu?

A.

One

B. Two
C.
D. No selection is needed

Three
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Correct answer: A

Explain ways to avoid rendering unnecessary pixels.

Which setting in the Composition and Layer panels determines how many pixels After Effects
renders?

A. Exposure

B. Resolution

C. Magnification

D. Color Management Settings

Correct answer: B

List and describe the options available for formatting fill and stroke.

You want to create text in a comic book style, where the stroke is much bigger than the fill but
doesn’t obscure the letters. Which option in the Stroke pull- down menu in the Character Pal-
ette should you use?

A. Fill Over Stroke
B. Stroke Over Fill
C. All Strokes Over All Fills
D. All Fills Over All Strokes

Correct answer: D

List and describe video formats which support XMP metadata upon import.

Where can you find the frame rate and frame size information embedded in Extensible Meta-
data Platform (MXF) files?

A. go to Window > Metadata, look under Files and twirl down Basic

B. goto Window > Metadata, look under Files and twirl down EXIF Schema
C. go to Window > Metadata, look under Project and twirl down Dublin Core
D. goto Window > Metadata, look under Files and twirl down Dynamic Media

Correct answer: D
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Discuss Render Multiple Frames Simultaneously.

You are working with a complex After Effects composition and are using the Render Multiple
Frames Simultaneously feature. After Effects posts an "Incompatible Preview mode. Multi-
processing is off.” message in the Info panel and temporarily disables the Render Multiple
Frames Simultaneously feature. Which After Effects feature or setting causes this message to
appear in the Info panel?

A. A.OpenGL previews are enabled.

B. B.The Disk Cache feature is enabled.

C. C.Live Update is disabled in the Timeline panel.
D. D.The Segment Movie Files At setting is to high.

Correct answer: A

Explain how to temporarily disable an expression.

When editing a transform property in the Timeline panel, you wish to temporarily disable an
expression you have used on the property. Which action in the Timeline panel will temporarily
disable the expression on the property?

A. enable the Caps Lock key on the keyboard

B. Shift click on the Show Post-Expression graph

C. click on the Enable Expression switch for the property

D. Alt key (Windows) or Option key (Mac OS) click on the Time Vary Stopwatch for the
property

Correct answer: C
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